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1 Introduction 
 
1.1 Configuration methods 

This document was created based on receiver firmware version 5.0.1 and RxTools version 
16.2.0. RxTools will run on Windows 7 and later or Fedora15 and later. RxTools is a group 
of programs and we will be using RxControl to configure the receiver. A copy of the latest 
version of RxTools can be found at http://www.septentrio.com/support. Users can request 
credentials by e-mailing support@septentrio.com 
 
There are two* main methods that can be used to configure the PolaRx5. One is through 
the web GUI interface and the other is using RxControl. While it is possible to setup almost 
all configuration parameters through the web GUI it can become difficult to create more 
complex setups. For applying many changes at once the use of RxControl and 
configuration scripts is preferable. You can connect to the web interface using the Ethernet 
port or WiFi. To turn on WiFi there is an icon/button on the front right of the receiver. Once 
activated it will show up on you computer as a WiFi network. For power savings and 
security make sure the WiFi is off before leaving site. 
 
The simplest way to make an initial connection to the receiver is using RxControl and a 
serial connection to COM1 on the receiver. If your PC does not have a serial port use a 
serial to USB adaptor and it will get assigned a COM port or dev that can be selected when 
creating the connection in RxControl. See section 4 for more information on RxControl 
usage. 
 
The UNAV base configuration found below in section 4.11 UNAV_X5_5-0-1_base_001.txt 
should be applied first. To customize user passwords and access for PBO apply the 
additional file in section 4.35 PBO_X5_5-0-1_user-admin_001.txt. 
 
To inform the user how to set up various parts of the configuration examples are provided 
using the web GUI and the equivalent using scripts and RxControl. With the understanding 
of these steps the user should be able to successfully make modifications to the receiver 
using either method. 
 
To apply initial configuration it is best, if possible, to start by resetting the receiver to 
default. If the receiver is being moved to a new site it may also be prudent to format the 
internal drive to remove all stored data. Care should be taken that before formatting that all 
data is saved/archived as needed. Data is not recoverable after format. Once the receiver 
is cleaned apply the base script and user-admin script if necessary. 
 
The base configuration script is organized in sections similar to the way the file is read and 
output from the receiver. If you want to edit the configuration to apply only sections you can 
simply comment out the unwanted sections or use the task specific example scripts 
provided. An example would be the IP setting. Generally if you are working on a unit that is 
deployed you would want to comment this out. If you are setting up many receivers in the 
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office you may want to set the IP of all receivers the same. 
 
*The receiver can also be configured using a basic terminal program. The 
command/response is similar to using the ‘Expert Console’. There are many things that can 
be accomplished programmatically but those topics are beyond the scope of this document. 
For more information on the operational details and command reference please see the 
“PolaRx5 GNSS Firmware v5.0.1 Reference Guide” that is available on the Septentrio web 
site. 
 

1.2 Notes on UNAVCO base configuration 
COM1 port is left set to default for a maintenance port. If you arrive at an installed unit and 
need to connect quickly to recover data or check receiver status use serial cable 
CBLe_COM_1.8 p/n 200416 and RxControl. 
UNAV_X5_5-0-1_base_001.txt is set up to record met data from a WXT5n0 met pack, 
when installed, that has the standard UNAV configuration. All that needs to be done is plug 
the metpack into COM2. If using Septentrio cable ‘CBLe_COM_1.8 C000003601 you will 
need to use a null adapter and gender changer. When available you can use 
CBLe_COM_1.8_M p/n 215143 without the need for adaptors. Go to the ‘External Sensor’ 
section under the ’Station’ tab and check for met string to appear. The sample rate is set to 
5min and the data will be recorded in the ‘A’ and ‘M’ sessions. 
 
The base configuration saves a copy in the ‘User1” file so by coping User1 to Current and 
saving to boot the receiver can be set back to UNAV default. If changes are made to 
“Current” you should answer ‘Save to Boot’ in the box that appears in the lower right corner. 
This will save a copy of current to Boot so on the next reboot changes will not be lost. If you 
would like to save the modified configuration you should save it to ‘User2”.  
 
If editing any script be aware that the order that lines are applied does matter.  

 
1.3 Adding functionality 

To add an external disk you can run the script ‘UNAV_X5_5-0-1_ext_ses_001.txt’ using 
RxControl. The script can be edited to reflect a different session name, sampling rate or file 
size. 
 
To add a tiltmeter you can run the script ‘PBO_X5_5-0-1_Tiltmater-port3_001.txt’. Use the 
dual (COM3.4) serial cable (CBLe_COM_DUO7 p/n C000006601) and plug the tiltmeter in 
to the port 3 connector. Gender and null modem adaptors are required with this cable. We 
are creating a cable that will be available in the future that will not need adaptors. 
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2 Site Installation 
 
2.1 Cables minimum 

To install a PolaRx5 GNSS receiver you will need, at a minimum, the following cables. 
-DC power open ended CBL_PWR_OE  p/n C000001101 
-Ethernet   CBLe_ETH_MS  p/n 200418 
-Cable or adaptor to connect to female TNC for antenna. 
The receiver requires 9-30V for operation. 
 

2.2 Cables for metpack 
If installing a met pack you will need the following cable. 
-Serial met/tilt  CBLe_COM_1.8_M  p/n 215143 
or 
-Serial   CBLe_COM_1.8  p/n 200416 
If you use the optional cable you will need to provide a gender changer and a null modem 
adapter. The cable can be easily identified by the part number or the gender of the 9-pin 
connector. Cable p/n 215143 has a male connector and p/n 200416 has a female 
connector. 
The receiver will not power external devices so power must be provided separately. 
  

2.3 Cables for tiltmeter or other serial device 
If installing a tiltmeter or other serial device you will need the following cable. 
-COM3,COM4 cable  CBLe_COM_DUO7  p/n C000006601 
This dual serial cable requires a null modem adapter and gender changer on each 9-pin 
connector. COM3 is the 9-pin connector in the middle and COM4 is the 9-pin connector at 
the end. A new cable that does not require adapters will be available soon. 
The receiver will not power external devices so power must be provided separately. 

 
2.4 External USB drive 

We are currently evaluating the use of external USB drives. An external drive up to 32GB 
The PolaRx5 receiver supports the use of an external USB drive of up to 23GB for 
additional storage. We are currently evaluating the use of external USB drives and will 
make recommendations for use once completed. 
To connect use the following cable in the port identified with the USB icon. 
-USB ext. drive  CBLe_USB_HOST p/n 214935 
See section 3.4 or 4.21 in the Unav_PolaRx5_Setup guide for instruction on how to 
configure logging to an external drive. 
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3 Using Browser Web GUI to Configure 
 
Before changes can be made to the configuration you must log in. Click on the ‘Log in’ 
button in the top center and you will be prompted for credentials. If you would like to log out 
of the receiver click on the ‘Log out’ button in the top right corner and you will be prompted 
again but this time leave the fields blank and click ‘OK’. Most current browsers work well 
however problems have been reported when using Safari. If you use Safari to log in you will 
need to check the ‘Save this password in my keychain’ dialog box.  
 

3.1 Setup Ethernet 
GoTo ‘Communication > Ethernet’ 
 -Verify under ‘Ethernet interface mode’ that the Power is set to ‘on’. 
 -Set up the ’TCP/IP’ information with the correct local network settings.  
 
 Check ‘OK’ and save to Boot. 
 ***Changes to network setting do not take effect until a reboot is performed. 
 
UNAV default shown below. 

 
 
 

3.2 Set SV Tracking 
GoTo ‘GNSS > Spectrum’ 

-Set ‘AGC Mode’ and ’Notch Filters’ as necessary. Care should be taken when adjusting 
these parameters. Adjust these options if RF noise sources appear to be affecting data 
quality. 
More information can be found in the ‘Polarx5_user_manual’ and the ‘PolaRx5 GNSS 
Firmware v5.0.1 Reference Guide’.   
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The UNAV default is to leave filters disabled as indicated below with noise issues 
assessed on an individual basis. 

 

 
 
 
GoTo ‘GNSS > Satellites and Signals’ 
 -Select SV signals you wish to track. 
 UNAV setting track all signals except GLOL1P and GLOL2P as indicated. 
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3.3 Setup Stream 

GoTo ‘Communication > IP Ports’ 
 -Set IPS connection Port, Mode and UDPAddress.  
 For UNAV set IPS1 with Port=42042, Mode=TCP and UDPAddress=255.255.255.255. 
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GoTo’NMEA/SBF Out’ Tab 
 -Click the ‘Add Stream’ button. 
 -Select type of stream. UNAV is using an SBF stream. 
 -Click ’Next’. 
 

 
 
 -Select the IPS port chosen under ‘Communication > IP Ports’ 
 UNAV selected IPS1. 
 -Click ’Next’. 
 

 
 
 -Select the messages you want to be included in the stream. 
 UNAV enables the following- 
  Measurements - MeasEpoch 
  GPS - GPSNav 
    GPSIon 
    GPSUtc 
  GLO - GLONav 
  GAL - GALNav 
    GALUtc 
    GALGstGps 
  GEO - GEONav 
  CMP - CMPNav 
  QZS - QZSNav 
  PVTGeod - PVTGeodetic 
  ReceiverSetup 
  ASCIIIn <—— Only if met/tilt data is to be included. 
 -Click ’Next’. 
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 -Select the data stream interval.  
 UNAV sets the stream to 1sec. 
 -Click ’Next’. 
 
 Check ‘OK’ and save to Boot. 
 

 
 

 
3.4 Setup new internal/external session 

GoTo ‘Logging > Log Sessions” 
-Select ‘Create’ to the right of the next available Log ID.  

UNAV LOGS are LOG1=A, LOG2=B, LOG3=C, LOG4=M, LOG8=STATUS 
 

 
 
 
 -Enter ‘Session Name’ -User should verify that the chosen name is valid. Standard 

UNAV options are A, B, C, M and STATUS. 
 -Enter ‘Disk”   -Internal or External 
 -Enter ‘Auto Delete’ time -The disk size and storage of other session should be 

considered when choosing how much data to store. See Data Storage Estimation for 
more information. 
UNAV files are Internal and A=‘After 1 year’, B=‘After 30 days’, C=‘After 7 days’, 
M=‘After 3 days’ and STATUS=‘After 30 days’. 
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GoTo ’SBF Logging’ tab and select ’New SBF stream’. 
 -Set the sampling rate in the pulldown menu.  
 UNAV files are A=15sec, B=1Hz, C=5Hz, M=15sec. 
 
 Select the following messages- 
  Measurements - MeasEpoch 
  GPS - GPSNav 
    GPSIon 
    GPSUtc 
  GLO - GLONav 
  GAL - GALNav 
    GALUtc 
    GALGstGps 
  GEO - GEONav 
  CMP - CMPNav 
  QZS - QZSNav 
  PVTGeod - PVTGeodetic 
  ReceiverSetup 
  ASCIIIn <—— Only if met/tilt data is to be recorded (sessions A and M). 
 
 -Set the ’Naming Type’ to IGS15min, 1H, 6H, 24H. 
 UNAV files are A=IGS24H, B=IGS1H, C=IGS1H, M=IGS1H. 
 
 Apply and save to Boot. 
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GoTo ‘Logging > Disk Full Management’ 
 -Set LOG files priority for overwrite. File size management can also be accomplished 

through ‘Auto-Delete’ function.  
 The UNAV configuration leaves the priority set as indicated below and sets Auto-Delete 

when creating/editing LOG files. 
 
 Apply and save to Boot. 
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3.5 Setup receiver metadata 
GoTo ‘Station > Name and Marker’ 
 -Update all fields from pnnn or (SEPT) to the station 4-character ID.  If receiver is 

defaulted set other fields as indicated below. 
 
 All characters in the pnnn fields must be lower case. 
 
 Check ‘OK’ and save to Boot. 
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GoTo ‘Station > Antenna’ 
 -Set Delta U for antenna height and Delta E and/or N for other offsets. UNAV SCIGN 

mount height, Delta U = 0.0083 M. 
 -Set ‘Antenna Type’ in pull-down menu to appropriate antenna/dome combination. 

For PBO sites the antenna will be TRM59800.00 or TRM59800.80 with domes tall=’SCIT’ 
or short=’SCIS’. 

 -Update antenna serial number upon site installation. 
 
 Check ‘OK’ and save to Boot. 
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GoTo ‘Station > Position’ 
 -Set ‘Position Mode’ to ’Static’. 
 
 Check ‘OK’ and save to Boot. 
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GoTo ‘GNSS > Timing’ 
 -Set ‘Clock Sync Threshold / Clock Steering’ to ‘ClockSteering’. 

 -Under ‘10-MHz REF OUT Configuration’ verify both ‘Enable REF OUT signal’ and 
‘Enable disciplining to GNSS frequency’ are set to ‘off’. 

 
 Check ‘OK’ and save to Boot. 
 

 
 
 
 
3.6 Setup new met or tilt logging 

GoTo ’Station > External Sensor’ 
 -Under ‘Enable ASCII Input’ check COM2* 
 

-Under ’Set Periodic Echo’ set the Message and repeat Interval. For the WXT5n0 
metpacks set the Message to ‘A:0R0%%CR%%LF’ and for the Lily tiltmeter set it to 
‘A:*0100XY%%CR%%LF’. 

 The normal sample rate for UNAV met data is 5min. 
 
 Check ‘OK’ and save to boot. 
 

 
  
 
GoTo ‘ Corrections > Corrections Input’ 
 -Under COM2 (or other port) select ‘ASCIIIN’. 
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 Check ‘OK’ and save to Boot. 
 

 
 
 
GoTo ‘Logging > Log Sessions’ 
 -For normal UNAV setup save met or tilt data to the ‘A’ and ‘M’ sessions. 
 Enter the editor for the session you wish to save the data to. 
 Go to the ‘SBF Logging’ tab then open the ‘Messages’ editor. 
 In the editor scroll down and check ‘ASCIIIn’. 
 
 Check ‘Apply’, ‘Apply’, ‘Apply’ then save to Boot. 
 

 
 
 
 
3.7 Setup Users and Login Credentials 

GoTo ‘Admin > User Administration’ 
 -Set user login and privileges. 
 For PBO set as follows. 
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3.8 Resetting Receiver 
The Ethernet configuration is not reset during any of the following operations. 
To reset the receiver to default there are two options. 
Option 1 
GoTo ‘Admin > Reset’. 

-Check all boxes and the ‘OK’. 
-When the ‘Reset Confirmation’ message appears click ‘Reset’ and wait for the receiver 
to reboot. 
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Option 2 
GoTo ‘Admin > Configurations’ 

-Select ‘RxDefault’ in the ‘Source’ pull-down menu, leave ‘Target set to ‘Boot’ and click 
‘OK’. In lower left corner click ‘Save’ and then reboot receiver. It will restart with default 
settings. 

 

 
 
To format the internal or external disk 
GoTo ‘Logging > Disk Contents’ 

-Click ‘Format’ then at the prompt click ‘format’ again. 
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4 Using RxControl to Configure 
  
Run the program RxControl for configuration of the unit. You can connect to the PolaRx5 
via serial or Ethernet. For serial connection use CBLe_COM_1.8 p/n 200416 and for 
Ethernet connection use CBLe_ETH_MS p/n 200418. Select the connection under ‘File’ > 
‘Change Connection’ or ‘Manage Connections’. Once connected go to ‘Tools’ > ‘Expert 
Console’ to open console and go to ‘File’ > ‘Upload script…’ (Ctrl+U) to load scripts. Be 
sure to check ‘NO’ in the dialog box that comes up asking ‘Reset SSRC7’s settings 
to default before applying the script?’ 
 
The scripts to be loaded can be downloaded from UNAVCO or the text can be copied from 
each section below and pasted into a text document. 
 
Use the ‘Expert Console’ to watch for errors or messages while loading the scripts. If the 
receiver is not defaulted and it has a password there are two approaches. 1) In the ‘Expert 
Console’ login by entering login,un,pw in the text field at bottom. 2) Uncomment (remove 
the ‘#’) from the line #login, username, password at the top of script and add the required 
credentials. 
 
 

4.1 UNAV Base configuration 
 
4.11 UNAV_X5_5-0-1_base_001.txt 
 

# Review and comment out sections such as # Metadata or # Set receiver IP. 
# If the receiver has already been configured it is recommended you reset the receiver to 

default and format the internal drive. 
# Save data before reformatting. 
 
# Setup streams 
setSBFOutput, Stream1, LOG1 
setSBFOutput, Stream2, LOG2 
setSBFOutput, Stream3, LOG3 
setSBFOutput, Stream4, LOG4 
setSBFOutput, Stream8, LOG8 
setSBFOutput, Stream16, IPS1 
setSBFOutput, Stream1, , 

MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav+ASCIIIN 

setSBFOutput, Stream2, , 
MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav 

setSBFOutput, Stream3, , 
MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
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GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav 
setSBFOutput, Stream4, , 

MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav+ASCIIIN 

setSBFOutput, Stream8, , 
MeasEpoch+MeasExtra+EndOfMeas+OutputLink+GPSRawCA+GPSRawL2C+GPS
RawL5+GLORawCA+GALRawFNAV+GALRawINAV+GALRawCNAV+GEORawL1+
GEORawL5+GPSNav+GPSAlm+GPSIon+GPSUtc+GLONav+GLOAlm+GLOTime+G
ALNav+GALAlm+GALIon+GALUtc+GALGstGps+GEONav+GEOAlm+BaseVectorGe
od+PVTGeodetic+PosCovGeodetic+DOP+EndOfPVT+ExtEvent+DiffCorrIn+BaseSt
ation+InputLink+ChannelStatus+ReceiverStatus+ReceiverSetup+Commands+CMP
Raw+IPStatus+QZSRawL1CA+QZSRawL2C+QZSRawL5+PVTSupport+CMPNav+
QualityInd+NTRIPClientStatus+WiFiAPStatus+RxComponents+DiskStatus+RFStatu
s+IRNSSRaw+QZSNav+WiFiClientStatus+LogStatus+RxMessage 

setSBFOutput, Stream16, , 
MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav 

setSBFOutput, Stream1, , , sec15 
setSBFOutput, Stream2, , , sec1 
setSBFOutput, Stream3, , , msec200 
setSBFOutput, Stream4, , , sec15 
setSBFOutput, Stream8, , , min2 
setSBFOutput, Stream16, , , sec1 
 
# Setup Met/Tilt 
setDataInOut, COM2, ASCIIIN 
setPeriodicEcho, COM2, 'A:0R0%%CR%%LF' 
setPeriodicEcho, COM2, , min5 
setCOMSettings, COM2, baud19200 
 
#Set up server port 42042 for stream 
setIPServerSettings, IPS1, 42042 
 
# Position 
setPVTMode, Static 
 
# Tracking 
setMultipathMitigation, off 
setMultipathMitigation, , off 
setSatelliteUsage, 

G01+G02+G03+G04+G05+G06+G07+G08+G09+G10+G11+G12+G13+G14+G15+
G16+G17+G18+G19+G20+G21+G22+G23+G24+G25+G26+G27+G28+G29+G30+
G31+G32+R01+R02+R03+R04+R05+R06+R07+R08+R09+R10+R11+R12+R13+R
14+R15+R16+R17+R18+R19+R20+R21+R22+R23+R24+R25+R26+R27+R28+R29
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+R30+E01+E02+E03+E04+E05+E06+E07+E08+E09+E10+E11+E12+E13+E14+E1
5+E16+E17+E18+E19+E20+E21+E22+E23+E24+E25+E26+E27+E28+E29+E30+E
31+E32+S120+S121+S122+S123+S124+S125+S126+S127+S128+S129+S130+S1
31+S132+S133+S134+S135+S136+S137+S138+S139+S140+S141+S142+S143+S
144+S145+S146+S147+S148+S149+S150+S151+S152+S153+S154+S155+S156+
S157+S158+C01+C02+C03+C04+C05+C06+C07+C08+C09+C10+C11+C12+C13+
C14+C15+C16+C17+C18+C19+C20+C21+C22+C23+C24+C25+C26+C27+C28+C2
9+C30+C31+C32+C33+C34+C35+C36+C37 

setSignalUsage, 
GPSL1CA+GPSL1PY+GPSL2PY+GPSL2C+GPSL5+GLOL1CA+GLOL2CA+GLOL3
+GALL1BC+GALE6BC+GALE5a+GALE5b+GALE5+GEOL1+GEOL5+CMPL1+CMP
E5b+CMPB3 

setSignalUsage, , 
GPSL1CA+GPSL1PY+GPSL2PY+GPSL2C+GPSL5+GLOL1CA+GLOL2CA+GLOL3
+GALL1BC+GALE6BC+GALE5a+GALE5b+GALE5+GEOL1+GEOL5+CMPL1+CMP
E5b+CMPB3+QZSL1CA+QZSL2C+QZSL5 

setSignalTracking, 
GPSL1CA+GPSL1PY+GPSL2PY+GPSL2C+GPSL5+GLOL1CA+GLOL2CA+GLOL3
+GALL1BC+GALE6BC+GALE5a+GALE5b+GALE5+GEOL1+GEOL5+CMPL1+CMP
E5b+CMPB3+QZSL1CA+QZSL2C+QZSL5+IRNL5 

setNotchFiltering, Notch1, off 
setNotchFiltering, Notch2, off 
setNotchFiltering, Notch3, off 
 
# Clock 
setClockSyncThreshold, ClockSteering 
setREFOUTMode, off 
 
# Metadata 
setAntennaOffset, Main, , , 0.0083 
setAntennaOffset, Main, , , , 'TRM59800.00     SCIT' 
setMarkerParameters, 'pnnn' 
setMarkerParameters, , 'pnnn' 
setMarkerParameters, , , 'pnnn' 
setMarkerParameters, , , , 'pnnn' 
setMarkerParameters, , , , , , , 'USA' 
setObserverParameters, 'UNAVCO' 
setObserverParameters, , 'UNAVCO' 
 
# Setup sessions 
setLogSession, LOG1, Enabled 
setLogSession, LOG2, Enabled 
setLogSession, LOG3, Enabled 
setLogSession, LOG4, Enabled 
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setLogSession, LOG8, Enabled 
setLogSession, LOG1, , , 'A' 
setLogSession, LOG2, , , 'B' 
setLogSession, LOG3, , , 'C' 
setLogSession, LOG4, , , 'M' 
setLogSession, LOG8, , , 'STATUS' 
setLogSession, LOG1, , , , After1Year 
setLogSession, LOG2, , , , After30Days 
setLogSession, LOG3, , , , After7Days 
setLogSession, LOG4, , , , After3Days 
setLogSession, LOG8, , , , After30Days 
setLogSession, LOG1, , , , , High 
setLogSession, LOG2, , , , , High 
setLogSession, LOG3, , , , , High 
setLogSession, LOG4, , , , , High 
setLogSession, LOG8, , , , , Medium 
setFileNaming, LOG1, IGS24H 
setFileNaming, LOG2, IGS1H 
setFileNaming, LOG3, IGS1H 
setFileNaming, LOG4, IGS1H 
setFileNaming, LOG8, IGS24H 
 
# Set receiver IP 
#setIPSettings,Static,192.168.1.2,255.255.255.0,192.168.1.1 
 
# copy config to Boot and User1 
exeCopyConfigFile,Current,Boot 
exeCopyConfigFile,Current,User1 
#exeCopyConfigFile,RxDefault,User2 

 
 
 
4.2 Adding Functionality to base configuration 
 
4.21 UNAV_X5_5-0-1_ext_ses_001.txt 
 

# Login to make changes if necessary 
#login, username, password 
 
# Setup Logging sessions for External DSK2 
setSBFOutput, Stream5, LOG5 
setSBFOutput, Stream5, , 

MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav 
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setSBFOutput, Stream5, , , sec15 
setLogSession, LOG5, , DSK2 
setLogSession, LOG5, Enabled 
setLogSession, LOG5, , , 'AE' 
setLogSession, LOG5, , , , After1Year 
setLogSession, LOG5, , , , , High 
setFileNaming, LOG5, IGS24H 
 
# copy config to Boot 
exeCopyConfigFile,Current,Boot 

 
 
4.22 PBO_X5_5-0-1_Tiltmater-port3_001.txt 
 

# Login to make changes if necessary 
#login, username, password 
 
# Setup Tilt 
setDataInOut, COM3, ASCIIIN 
setPeriodicEcho, COM3, 'A:*0100XY%%CR%%LF' 
setPeriodicEcho, COM3, , min5 
setCOMSettings, COM3, baud19200 
 
# copy config to Boot 
exeCopyConfigFile,Current,Boot 

 
 

 
4.3 Configuration Blocks 

 
To set up the configuration piecewise you can apply the following. Note the individual 
blocks are also saved to ‘User1’. This is so the results will be the same as loading 
UNAV_X5_5-0-1_base_001.txt in section 4.11. 

 
4.31 UNAV_X5_5-0-1_set-IP_001.txt 
 

Changes to network setting do not take effect until a reboot is performed. 
 
# Login to make changes if there is already a config installed. 
# Edit IP setting for you new network requirements. 
# For changes to take effect the receiver will need a reboot once this is applied. 
# Use care if you are using Ethernet for your current communications. 
#login, username, password 
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# Set receiver IP 
setIPSettings,Static,192.168.1.2,255.255.255.0,192.168.1.1 
 
# copy config to Boot 
exeCopyConfigFile,Current,Boot 
exeCopyConfigFile,Current,User1 

 
 
4.32 UNAV_X5_5-0-1_tracking_001.txt 
 

# Login to make changes if necessary 
#login, username, password 
 
# Tracking 
setMultipathMitigation, off 
setMultipathMitigation, , off 
setSatelliteUsage, 

G01+G02+G03+G04+G05+G06+G07+G08+G09+G10+G11+G12+G13+G14+G15+
G16+G17+G18+G19+G20+G21+G22+G23+G24+G25+G26+G27+G28+G29+G30+
G31+G32+R01+R02+R03+R04+R05+R06+R07+R08+R09+R10+R11+R12+R13+R
14+R15+R16+R17+R18+R19+R20+R21+R22+R23+R24+R25+R26+R27+R28+R29
+R30+E01+E02+E03+E04+E05+E06+E07+E08+E09+E10+E11+E12+E13+E14+E1
5+E16+E17+E18+E19+E20+E21+E22+E23+E24+E25+E26+E27+E28+E29+E30+E
31+E32+S120+S121+S122+S123+S124+S125+S126+S127+S128+S129+S130+S1
31+S132+S133+S134+S135+S136+S137+S138+S139+S140+S141+S142+S143+S
144+S145+S146+S147+S148+S149+S150+S151+S152+S153+S154+S155+S156+
S157+S158+C01+C02+C03+C04+C05+C06+C07+C08+C09+C10+C11+C12+C13+
C14+C15+C16+C17+C18+C19+C20+C21+C22+C23+C24+C25+C26+C27+C28+C2
9+C30+C31+C32+C33+C34+C35+C36+C37 

setSignalUsage, 
GPSL1CA+GPSL1PY+GPSL2PY+GPSL2C+GPSL5+GLOL1CA+GLOL2CA+GLOL3
+GALL1BC+GALE6BC+GALE5a+GALE5b+GALE5+GEOL1+GEOL5+CMPL1+CMP
E5b+CMPB3 

setSignalUsage, , 
GPSL1CA+GPSL1PY+GPSL2PY+GPSL2C+GPSL5+GLOL1CA+GLOL2CA+GLOL3
+GALL1BC+GALE6BC+GALE5a+GALE5b+GALE5+GEOL1+GEOL5+CMPL1+CMP
E5b+CMPB3+QZSL1CA+QZSL2C+QZSL5 

setSignalTracking, 
GPSL1CA+GPSL1PY+GPSL2PY+GPSL2C+GPSL5+GLOL1CA+GLOL2CA+GLOL3
+GALL1BC+GALE6BC+GALE5a+GALE5b+GALE5+GEOL1+GEOL5+CMPL1+CMP
E5b+CMPB3+QZSL1CA+QZSL2C+QZSL5+IRNL5 

setNotchFiltering, Notch1, off 
setNotchFiltering, Notch2, off 
setNotchFiltering, Notch3, off 
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# copy config to Boot 
exeCopyConfigFile,Current,Boot 
exeCopyConfigFile,Current,User1 

 
 
4.33 UNAV_X5_5-0-1_42042stream_001.txt 
 

# Login to make changes if necessary 
#login, username, password 
 
# Setup stream. Available streams are 1-16. 
setSBFOutput, Stream16, IPS1 
setSBFOutput, Stream16, , 

MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav 

setSBFOutput, Stream16, , , sec1 
 
#Set up server port 42042 for stream 
setIPServerSettings, IPS1, 42042 
 
# copy config to Boot 
exeCopyConfigFile,Current,Boot 
exeCopyConfigFile,Current,User1 

 
 
4.34 UNAV_X5_5-0-1_sessions_001.txt 
 

# Login to make changes if necessary 
#login, username, password 
 
# Setup streams 
setSBFOutput, Stream1, LOG1 
setSBFOutput, Stream2, LOG2 
setSBFOutput, Stream3, LOG3 
setSBFOutput, Stream4, LOG4 
setSBFOutput, Stream8, LOG8 
setSBFOutput, Stream16, IPS1 
setSBFOutput, Stream1, , 

MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav+ASCIIIN 

setSBFOutput, Stream2, , 
MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav 
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setSBFOutput, Stream3, , 
MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav 

setSBFOutput, Stream4, , 
MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav+ASCIIIN 

setSBFOutput, Stream8, , 
MeasEpoch+MeasExtra+EndOfMeas+OutputLink+GPSRawCA+GPSRawL2C+GPS
RawL5+GLORawCA+GALRawFNAV+GALRawINAV+GALRawCNAV+GEORawL1+
GEORawL5+GPSNav+GPSAlm+GPSIon+GPSUtc+GLONav+GLOAlm+GLOTime+G
ALNav+GALAlm+GALIon+GALUtc+GALGstGps+GEONav+GEOAlm+BaseVectorGe
od+PVTGeodetic+PosCovGeodetic+DOP+EndOfPVT+ExtEvent+DiffCorrIn+BaseSt
ation+InputLink+ChannelStatus+ReceiverStatus+ReceiverSetup+Commands+CMP
Raw+IPStatus+QZSRawL1CA+QZSRawL2C+QZSRawL5+PVTSupport+CMPNav+
QualityInd+NTRIPClientStatus+WiFiAPStatus+RxComponents+DiskStatus+RFStatu
s+IRNSSRaw+QZSNav+WiFiClientStatus+LogStatus+RxMessage 

setSBFOutput, Stream16, , 
MeasEpoch+GPSNav+GPSIon+GPSUtc+GLONav+GALNav+GALUtc+GALGstGps+
GEONav+PVTGeodetic+ReceiverSetup+CMPNav+QZSNav 

setSBFOutput, Stream1, , , sec15 
setSBFOutput, Stream2, , , sec1 
setSBFOutput, Stream3, , , msec200 
setSBFOutput, Stream4, , , sec15 
setSBFOutput, Stream8, , , min2 
 
# Setup sessions 
setLogSession, LOG1, Enabled 
setLogSession, LOG2, Enabled 
setLogSession, LOG3, Enabled 
setLogSession, LOG4, Enabled 
setLogSession, LOG8, Enabled 
setLogSession, LOG1, , , 'A' 
setLogSession, LOG2, , , 'B' 
setLogSession, LOG3, , , 'C' 
setLogSession, LOG4, , , 'M' 
setLogSession, LOG8, , , 'STATUS' 
setLogSession, LOG1, , , , After1Year 
setLogSession, LOG2, , , , After30Days 
setLogSession, LOG3, , , , After7Days 
setLogSession, LOG4, , , , After3Days 
setLogSession, LOG8, , , , After30Days 
setLogSession, LOG1, , , , , High 
setLogSession, LOG2, , , , , High 
setLogSession, LOG3, , , , , High 
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setLogSession, LOG4, , , , , High 
setLogSession, LOG8, , , , , Medium 
setFileNaming, LOG1, IGS24H 
setFileNaming, LOG2, IGS1H 
setFileNaming, LOG3, IGS1H 
setFileNaming, LOG4, IGS1H 
setFileNaming, LOG8, IGS24H 
 
# copy config to Boot 
exeCopyConfigFile,Current,Boot 
exeCopyConfigFile,Current,User1 

 
 
4.35 UNAV_X5_5-0-1_meta_001.txt 
 

# Login to make changes if necessary 
#login, username, password 
 
# Metadata 
setAntennaOffset, Main, , , 0.0083 
setAntennaOffset, Main, , , , 'TRM59800.00     SCIT' 
setMarkerParameters, 'pnnn' 
setMarkerParameters, , 'pnnn' 
setMarkerParameters, , , 'pnnn' 
setMarkerParameters, , , , 'pnnn' 
setMarkerParameters, , , , , , , 'USA' 
setObserverParameters, 'UNAVCO' 
setObserverParameters, , 'UNAVCO' 
 
# copy config to Boot and User1 
exeCopyConfigFile,Current,Boot 
exeCopyConfigFile,Current,User1 

 
 
4.36 PBO_X5_5-0-1_user-admin_001.txt 

You must edit the login un/pw for this script to work! 
 

# Setup PBO Login Credentials 
setUserAccessLevel, User1, 'pbo' 
setUserAccessLevel, User1, , '8CODZDSFGI3FZS1TX1EQ62A98UR' 
 
# Login to complete changes 
login, un, pw 
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setUserAccessLevel, User2, 'unavco' 
setUserAccessLevel, User2, , '814VI4ROF77L3QZ1ZDXFLOZPZU2' 
setDefaultAccessLevel, Viewer 
setDefaultAccessLevel, , Viewer 
setDefaultAccessLevel, , , Viewer 
setDefaultAccessLevel, , , , Viewer 
setDefaultAccessLevel, , , , , Viewer 
 
# copy config to Boot 
exeCopyConfigFile,Current,Boot 
exeCopyConfigFile,Current,User1 

 
 
4.4 Resetting Receiver 

The Ethernet configuration is not reset for any of the following commands. 
  
To reset configuration to default. 
GoTo ‘File > Reset Receiver’  
 Select ‘All’ and ‘OK’. 
 
In the expert console or in a script run the following command. 
 exeCopyConfigFile,RxDefault,Boot 
 Reboot the receiver 
 
To format the internal or external disk. 
GoTo ‘Logging > Disk Management’ 
 Select appropriate disk, ‘Format’ and ‘OK’. 
 
In the expert console or in a script run the following command. 
 exeManageDisk ,DSK1,Format 

Change to DSK2 for external disk. 
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6.0 Data Storage Estimation 
 

File size can/will change over time as new SVs are placed in service. The user should be 
conservative when choosing the amount of data to be stored. If the memory is over 
allocated there could be data loss. Also it may be necessary to review the data allocation of 
all sessions if new sessions, constellations, signals, etc. are added.  
The receivers purchased for PBO have 16GB of internal memory available and the external 
drive can be up to 32GB. This memory is only used for data storage. 
 
Data file size examples 
15sec 1hr files all constellations - 390KB 
15sec 24hr files all constellations - 8.5MB 
1Hz 1hr files all constellations - 4.7MB 
1Hz 24hr files all constellations - 110.6MB 
5Hz 1hr files all constellations - 21.4MB 
5Hz 24hr files all constellations - 517.2MB 
 
15sec 1hr files GPS+GLONASS - 348KB 
15sec 24hr files GPS+GLONASS - 7.4MB 
1Hz 1hr files GPS+GLONASS - 4.7MB 
1Hz 24hr files GPS+GLONASS - 110MB 
5Hz 1hr files GPS+GLONASS - 22MB 
5Hz 24hr files GPS+GLONASS - 520MB 
 
15sec 1hr files GPS only - 345.7KB 
15sec 24hr files GPS only - 7.3MB 
1Hz 1hr files GPS only - 4.7MB 
1Hz 24hr files GPS only - 109MB 
5Hz 1hr files GPS only - 22MB 
5Hz 24hr files GPS only - 520MB 
 
In order to achieve substantial file size reduction by turning off constellations you must turn 
off satellite tracking and signals under ‘GNSS > Satellites and Signals’. If these are turned 
off the messages will not be available for any LOG sessions. 
 
Data file size examples with Satellites and Signals disabled. 
15sec 1hr files all constellations - 390KB 
15sec 24hr files all constellations - 8.5MB 
1Hz 1hr files all constellations - 4.7MB 
1Hz 24hr files all constellations - 110.6MB 
5Hz 1hr files all constellations - 21.4MB 
5Hz 24hr files all constellations - 517.2MB 
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15sec 1hr files GPS+GLONASS -  
15sec 24hr files GPS+GLONASS -  
1Hz 1hr files GPS+GLONASS -  
1Hz 24hr files GPS+GLONASS -  
5Hz 1hr files GPS+GLONASS -  
5Hz 24hr files GPS+GLONASS -  
 
15sec 1hr files GPS only -  
15sec 24hr files GPS only -  
1Hz 1hr files GPS only -  
1Hz 24hr files GPS only -  
5Hz 1hr files GPS only -  
5Hz 24hr files GPS only -  
 


